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Purpose of the document 
The purpose of this document is to provide a description of how to call operations of the Magensa 
Remote Services web service. 
 
Information in this document is subject to change without notice. No part of this document may be 
reproduced or transmitted in any form or by any means, electronic or mechanical, for any purpose, 
Without the express written permission of Magensa LLC. 
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1 Introduction 
The purpose of this document is to provide a description of how to call operations of the Magensa Remote 
Services web service. 

2 SCRAv2 Operations 

2.1 GetKeyList 
 

2.1.1 INPUT PROPERTIES 
Property(*) Value Value Description 

CustomerCode * <string> Customer code 

Username * <string> The User Identification credential created and assigned by 
MagTek. 

Password * <string> The password for the credential. 

BillingLabel <string> Billing Label 

CustomerTransactionID <string> Customer transaction ID 
 
Note: * = Required 

2.1.2 OUTPUT PROPERTIES 
Property Value Value Description 

CustomerTransactionId <string> Customer transaction ID 

MagTranId <string> Magensa assigned unique transaction ID in GUID form. 

Description <string> Description 

ID int Key ID 

KSI <string> Key Serial ID 

KeyName <string> Name of the Key 

KeySlotNamePrefix <string> Name of the Slot E.g.: Prod or Test 
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GetKeyList Request: 
<soapenv:Envelope 
xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:v2="http://www.magensa.net/RemoteServices/v2/" 
xmlns:rem="http://schemas.datacontract.org/2004/07/RemoteServicesv2.Co
re"> 
 <soapenv:Header/> 
 <soapenv:Body> 
 <v2:GetKeyList> 
 <v2:request> 
 <rem:Authentication> 
 <rem:CustomerCode>customercode</rem:CustomerCode> 
 <rem:Password>password</rem:Password> 
 <rem:Username>username</rem:Username> 
 </rem:Authentication> 
 <rem:BillingLabel>Billing</rem:BillingLabel> 
 <rem:CustomerTransactionID>456</rem:CustomerTransactionID> 
 </v2:request> 
 </v2:GetKeyList> 
</soapenv:Body> 
</soapenv:Envelope> 
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GetKeyList Response: 
<s:Envelope xmlns:s="http://schemas.xmlsoap.org/soap/envelope/"> 
 <s:Body> 
 <GetKeyListResponse 
xmlns="http://www.magensa.net/RemoteServices/v2/"> 
 <GetKeyListResult 
xmlns:a="http://schemas.datacontract.org/2004/07/RemoteServicesv2.Core
" 
xmlns:i="http://www.w3.org/2001/XMLSchema-instance"> 
 <a:CustomerTransactionId>456</a:CustomerTransactionId> 
 <a:MagTranId>7c7ea90e-8a4b-48b1-9e31-dacabc0a14ca</a:MagTranId> 
 <a:Keys> 
 <a:Key> 
 <a:Description>The test key for Magensa</a:Description> 
<a:ID>7</a:ID> 
<a:KSI>9999990</a:KSI> 
<a:KeyName>Magensa TEST Key</a:KeyName> 
<a:KeySlotNamePrefix>Test</a:KeySlotNamePrefix> 
 </a:Key> 
 <a:Key> 
 <a:Description>the Test key for QwickKey</a:Description> 
<a:ID>8</a:ID> 
<a:KSI>9011400</a:KSI> 
<a:KeyName>QwickKey Test</a:KeyName> 
<a:KeySlotNamePrefix>Test</a:KeySlotNamePrefix> 
 </a:Key> 
 <a:Key> 
 <a:Description>the test key we use for ANSI test</a:Description> 
<a:ID>12</a:ID> 
<a:KSI>9010010</a:KSI> 
 <a:KeyName>ANSI Test Key</a:KeyName> 
 <a:KeySlotNamePrefix>Test</a:KeySlotNamePrefix> 
 </a:Key> 
 </a:Keys> 
 </GetKeyListResult> 
 </GetKeyListResponse> 
 </s:Body> 
</s:Envelope> 
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2.2 GetKeyLoadCommand 
A command used to calculate the command to change from one DUKPT key to another securely. 

2.2.1 INPUT PROPERTIES 
Property(*) Value Value Description 

CustomerCode * <string> Customer code 

Username * <string> The User Identification credential created and assigned by 
MagTek. 

Password * <string> The password for the credential. 

BillingLabel <string> Billing Label 

CustomerTransactionID <string> Customer transaction ID 

KSN * <string> Key Serial Number of the reader. 

KeyID * int The ID of the Key to be loaded. 

UpdateToken * <string> Update token obtained from the reader using command 19. 
 

2.2.2 OUTPUT PROPERTIES 
Property Value Value Description 

CustomerTransactionId <string> Customer transaction ID 

MagTranId <string> Magensa assigned unique transaction ID in GUID form. 

CommandType int CommandType value 

Description <string> Description of the command response. 

ExecutionTypeEnum <string> Execution type enumeration 

ID int ID of the command response. 

Name <string> Name representing the function for Value. 

Value <string> Value to be passed based on the type of command 
E.g. To change key for a SCRA device, 
ChangeKey value to be considered from 
response 
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GetKeyLoadCommand Request: 
<soapenv:Envelope 
xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:v2="http://www.magensa.net/RemoteServices/v2/" 
xmlns:rem="http://schemas.datacontract.org/2004/07/RemoteServicesv2.Co
re"> 
 <soapenv:Header/> 
 <soapenv:Body> 
 <v2:GetKeyLoadCommand> 
 <v2:request> 
 <rem:Authentication> 
 <rem:CustomerCode>customercode</rem:CustomerCode> 
 <rem:Password>password</rem:Password> 
 <rem:Username>username</rem:Username> 
 </rem:Authentication> 
 <rem:BillingLabel>Billing</rem:BillingLabel> 
<rem:CustomerTransactionID>456</rem:CustomerTransactionID> 
 <rem:KSN>9010010B28C0DC000038</rem:KSN> 
 <rem:KeyID>12</rem:KeyID> 
<rem:UpdateToken>423238433044433130313531344141004D53434B5453543030312
53035161C095998690C</rem:Upd 
ateToken> 
 </v2:request> 
 </v2:GetKeyLoadCommand> 
 </soapenv:Body> 
</soapenv:Envelope> 
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GetKeyLoadCommand Response: 
<s:Envelope xmlns:s="http://schemas.xmlsoap.org/soap/envelope/"> 
   <s:Body> 
      <GetKeyLoadCommandResponse 
xmlns="http://www.magensa.net/RemoteServices/v2/"> 
         <GetKeyLoadCommandResult 
xmlns:a="http://schemas.datacontract.org/2004/07/RemoteServicesv2.Core
" xmlns:i="http://www.w3.org/2001/XMLSchema-instance"> 
            <a:CustomerTransactionId>456</a:CustomerTransactionId> 
            <a:MagTranId>a37c9672-16e1-4774-921a-
07b384ea876a</a:MagTranId> 
            <a:Commands> 
               <a:Command> 
                  <a:CommandType>0</a:CommandType> 
                  <a:Description>To SCRA Device</a:Description> 
                  <a:ExecutionTypeEnum>ALL</a:ExecutionTypeEnum> 
                  <a:ID>0</a:ID> 
                  <a:Name>ChangeKey</a:Name> 
                  
<a:Value>223142323843304443313031353134414100019010010B28C0DC000000C8C
A8836AC81EE8C45D9AAA6419B38A9E512F571090E</a:Value> 
               </a:Command> 
               <a:Command> 
                  <a:CommandType>0</a:CommandType> 
                  <a:Description>Key Check Value</a:Description> 
                  <a:ExecutionTypeEnum>ALL</a:ExecutionTypeEnum> 
                  <a:ID>0</a:ID> 
                  <a:Name>KCV</a:Name> 
                  <a:Value>00311A2A3D</a:Value> 
               </a:Command> 
            </a:Commands> 
         </GetKeyLoadCommandResult> 
      </GetKeyLoadCommandResponse> 
   </s:Body> 
</s:Envelope> 
 

2.3 GetCommandList 
A command used to retrieve the list of available configuration commands. 

2.3.1 INPUT PROPERTIES 
Property(*) Value Value Description 

CustomerCode * <string> Customer code 

Username * <string> The User Identification credential created and assigned by 
MagTek. 

Password * <string> The password for the credential. 

BillingLabel <string> Billing Label 

CustomerTransactionID <string> Customer transaction ID 
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Property(*) Value Value Description 

ExecutionType * <string> The Execution Type can be one of the following values: 
ALL,KSN,MUT 

 
Note: * = Required 

2.3.2 OUTPUT PROPERTIES 
Property Value Value Description 

CustomerTransactionId <string> Customer transaction ID 

MagTranId <string> Magensa assigned unique transaction ID in GUID form. 

CommandType int CommandType value 

Description <string> Description of the command response. 

ExecutionTypeEnum <string> The Execution Type can be one of the following values: 
ALL,KSN,MUT 

ID int Command ID to be used for the following operations: 
GetCommandByMUT, GetCommandByKSN 

Name <string> Name of the command. 

Value <string> Value. Response may return a nil for this operation. 
 
GetCommandList Request: 
<soapenv:Envelope 
xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:v2="http://www.magensa.net/RemoteServices/v2/" 
xmlns:rem="http://schemas.datacontract.org/2004/07/RemoteServicesv2.Co
re"> 
 <soapenv:Header/> 
 <soapenv:Body> 
 <v2:GetCommandList> 
 <v2:request> 
 <rem:Authentication> 
 <rem:CustomerCode>customercode</rem:CustomerCode> 
 <rem:Password>password</rem:Password> 
 <rem:Username>username</rem:Username> 
 </rem:Authentication> 
 <rem:BillingLabel>Billing</rem:BillingLabel> 
 <rem:CustomerTransactionID>456</rem:CustomerTransactionID> 
 <rem:ExecutionType>ALL</rem:ExecutionType> 
 </v2:request> 
 </v2:GetCommandList> 
 </soapenv:Body> 
</soapenv:Envelope> 
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GetCommandList Response: 
<s:Envelope xmlns:s="http://schemas.xmlsoap.org/soap/envelope/"> 
   <s:Body> 
      <GetCommandListResponse 
xmlns="http://www.magensa.net/RemoteServices/v2/"> 
         <GetCommandListResult 
xmlns:a="http://schemas.datacontract.org/2004/07/RemoteServicesv2.Core
" xmlns:i="http://www.w3.org/2001/XMLSchema-instance"> 
            <a:CustomerTransactionId>456</a:CustomerTransactionId> 
            <a:MagTranId>258e70ce-d331-40a6-bf6e-
1875425739d1</a:MagTranId> 
            <a:Commands> 
               <a:Command> 
                  <a:CommandType>0</a:CommandType> 
                  <a:Description>Activity Timeout (Battery Operated 
devices Only)</a:Description> 
                  <a:ExecutionTypeEnum>KSN</a:ExecutionTypeEnum> 
                  <a:ID>37</a:ID> 
                  <a:Name>AvtivityTimeout_2Min</a:Name> 
                  <a:Value>010B78</a:Value> 
               </a:Command> 
               <a:Command> 
                  <a:CommandType>0</a:CommandType> 
                  <a:Description>Activity Timeout (Battery Operated 
devices Only)</a:Description> 
                  <a:ExecutionTypeEnum>KSN</a:ExecutionTypeEnum> 
                  <a:ID>38</a:ID> 
                  <a:Name>AvtivityTimeout_None</a:Name> 
                  <a:Value>010B00</a:Value> 
               </a:Command> 
               <a:Command> 
                  <a:CommandType>0</a:CommandType> 
                  <a:Description>Set Maximum Bound Count to 
1</a:Description> 
                  <a:ExecutionTypeEnum>KSN</a:ExecutionTypeEnum> 
                  <a:ID>1248</a:ID> 
                  <a:Name>BOND_MAX_COUNT_1</a:Name> 
                  <a:Value>NOMAC 46050100011601</a:Value> 
               </a:Command> 
               <a:Command> 
                  <a:CommandType>0</a:CommandType> 
                  <a:Description>Set Maximum Bound Count to 
2</a:Description> 
                  <a:ExecutionTypeEnum>KSN</a:ExecutionTypeEnum> 
                  <a:ID>1254</a:ID> 
                  <a:Name>BOND_MAX_COUNT_2</a:Name> 
                  <a:Value>NOMAC 46050100011602</a:Value> 
               </a:Command> 
               <a:Command> 
                  <a:CommandType>0</a:CommandType> 
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                  <a:Description>Set Maximum Bound Count to 
3</a:Description> 
                  <a:ExecutionTypeEnum>KSN</a:ExecutionTypeEnum> 
                  <a:ID>1255</a:ID> 
                  <a:Name>BOND_MAX_COUNT_3</a:Name> 
                  <a:Value>NOMAC 46050100011603</a:Value> 
               </a:Command> 
               <a:Command> 
                  <a:CommandType>0</a:CommandType> 
                  <a:Description>Set Maximum Bound Count to 
4</a:Description> 
                  <a:ExecutionTypeEnum>KSN</a:ExecutionTypeEnum> 
                  <a:ID>1256</a:ID> 
                  <a:Name>BOND_MAX_COUNT_4</a:Name> 
                  <a:Value>NOMAC 46050100011604</a:Value> 
               </a:Command> 
               <a:Command> 
                  <a:CommandType>0</a:CommandType> 
                  <a:Description>Set Maximum Bound Count to 
5</a:Description> 
                  <a:ExecutionTypeEnum>KSN</a:ExecutionTypeEnum> 
                  <a:ID>1249</a:ID> 
                  <a:Name>BOND_MAX_COUNT_5</a:Name> 
                  <a:Value>NOMAC 46050100011605</a:Value> 
               </a:Command> 
               <a:Command> 
                  <a:CommandType>0</a:CommandType> 
                  <a:Description>Set Maximum Bound Count to 
6</a:Description> 
                  <a:ExecutionTypeEnum>KSN</a:ExecutionTypeEnum> 
                  <a:ID>1257</a:ID> 
                  <a:Name>BOND_MAX_COUNT_6</a:Name> 
                  <a:Value>NOMAC 46050100011606</a:Value> 
               </a:Command> 
               <a:Command> 
                  <a:CommandType>0</a:CommandType> 
                  <a:Description>Set Maximum Bound Count to 
7</a:Description> 
                  <a:ExecutionTypeEnum>KSN</a:ExecutionTypeEnum> 
                  <a:ID>1258</a:ID> 
                  <a:Name>BOND_MAX_COUNT_7</a:Name> 
                  <a:Value>NOMAC 46050100011607</a:Value> 
               </a:Command> 
               <a:Command> 
                  <a:CommandType>0</a:CommandType> 
                  <a:Description>Set Maximum Bound Count to 
8</a:Description> 
                  <a:ExecutionTypeEnum>KSN</a:ExecutionTypeEnum> 
                  <a:ID>1259</a:ID> 
                  <a:Name>BOND_MAX_COUNT_8</a:Name> 
                  <a:Value>NOMAC 46050100011608</a:Value> 
               </a:Command> 
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               <a:Command> 
                  <a:CommandType>0</a:CommandType> 
                  <a:Description>Set Maximum Bound Count to 
9</a:Description> 
                  <a:ExecutionTypeEnum>KSN</a:ExecutionTypeEnum> 
                  <a:ID>1250</a:ID> 
                  <a:Name>BOND_MAX_COUNT_9</a:Name> 
                  <a:Value>NOMAC 46050100011609</a:Value> 
               </a:Command> 
               <a:Command> 
                  <a:CommandType>0</a:CommandType> 
                  <a:Description>Set Maximum Bound Mode to 
FIFO</a:Description> 
                  <a:ExecutionTypeEnum>KSN</a:ExecutionTypeEnum> 
                  <a:ID>1251</a:ID> 
                  <a:Name>BOND_MAX_MODE_FIFO</a:Name> 
                  <a:Value>NOMAC 46050100011700</a:Value> 
               </a:Command> 
               <a:Command> 
                  <a:CommandType>0</a:CommandType> 
                  <a:Description>Set Maximum Bound Mode to Non 
Pairable</a:Description> 
                  <a:ExecutionTypeEnum>KSN</a:ExecutionTypeEnum> 
                  <a:ID>1252</a:ID> 
                  <a:Name>BOND_MAX_MODE_NONPAIR</a:Name> 
                  <a:Value>NOMAC 46050100011701</a:Value> 
               </a:Command> 
               <a:Command> 
                  <a:CommandType>0</a:CommandType> 
                  <a:Description>Bulk Encryption 
Restricted</a:Description> 
                  <a:ExecutionTypeEnum>MUT</a:ExecutionTypeEnum> 
                  <a:ID>43</a:ID> 
                  <a:Name>Bulk_Encryption_Restricted</a:Name> 
                  <a:Value>1B3001</a:Value> 
               </a:Command> 
               <a:Command> 
                  <a:CommandType>0</a:CommandType> 
                  <a:Description>Bulk Encryption 
Unrestricted</a:Description> 
                  <a:ExecutionTypeEnum>MUT</a:ExecutionTypeEnum> 
                  <a:ID>44</a:ID> 
                  <a:Name>Bulk_Encryption_Unrestricted</a:Name> 
                  <a:Value>1B3000</a:Value> 
               </a:Command> 
               <a:Command> 
                  <a:CommandType>0</a:CommandType> 
                  <a:Description>Encrypt using Data 
Variant</a:Description> 
                  <a:ExecutionTypeEnum>MUT</a:ExecutionTypeEnum> 
                  <a:ID>42</a:ID> 
                  <a:Name>ENC_VARIANT_DATA</a:Name> 
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                  <a:Value>015401</a:Value> 
               </a:Command> 
               <a:Command> 
                  <a:CommandType>0</a:CommandType> 
                  <a:Description>Encrypt using PIN 
Variant</a:Description> 
                  <a:ExecutionTypeEnum>MUT</a:ExecutionTypeEnum> 
                  <a:ID>41</a:ID> 
                  <a:Name>ENC_VARIANT_PIN</a:Name> 
                  <a:Value>015400</a:Value> 
               </a:Command> 
               <a:Command> 
                  <a:CommandType>0</a:CommandType> 
                  <a:Description>Change Reader to Firmware Loader 
Mode</a:Description> 
                  <a:ExecutionTypeEnum>MUT</a:ExecutionTypeEnum> 
                  <a:ID>242</a:ID> 
                  <a:Name>FIRMWARE_LOADER_MODE_ENABLE</a:Name> 
                  <a:Value>91</a:Value> 
               </a:Command> 
               <a:Command> 
                  <a:CommandType>0</a:CommandType> 
                  <a:Description>Check Firmware Loader Mode 
Status</a:Description> 
                  <a:ExecutionTypeEnum>MUT</a:ExecutionTypeEnum> 
                  <a:ID>243</a:ID> 
                  <a:Name>FIRMWARE_LOADER_STATUS_CHECK</a:Name> 
                  <a:Value>90</a:Value> 
               </a:Command> 
               <a:Command> 
                  <a:CommandType>0</a:CommandType> 
                  <a:Description>Set Firmware Loader Target to BLE 
MCU</a:Description> 
                  <a:ExecutionTypeEnum>MUT</a:ExecutionTypeEnum> 
                  <a:ID>245</a:ID> 
                  <a:Name>FIRMWARE_LOADER_TARGET_BLE</a:Name> 
                  <a:Value>9701</a:Value> 
               </a:Command> 
               <a:Command> 
                  <a:CommandType>0</a:CommandType> 
                  <a:Description>Set Firmware Loader Target to MAIN 
MCU</a:Description> 
                  <a:ExecutionTypeEnum>MUT</a:ExecutionTypeEnum> 
                  <a:ID>244</a:ID> 
                  <a:Name>FIRMWARE_LOADER_TARGET_MAIN</a:Name> 
                  <a:Value>9700</a:Value> 
               </a:Command> 
               <a:Command> 
                  <a:CommandType>0</a:CommandType> 
                  <a:Description>Verify Boot Firmware Check 
Required</a:Description> 
                  <a:ExecutionTypeEnum>MUT</a:ExecutionTypeEnum> 
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                  <a:ID>246</a:ID> 
                  <a:Name>FIRMWARE_LOADER_VERIFICATION_CHECK</a:Name> 
                  <a:Value>92</a:Value> 
               </a:Command> 
               <a:Command> 
                  <a:CommandType>0</a:CommandType> 
                  <a:Description>Get UART Baud Rate</a:Description> 
                  <a:ExecutionTypeEnum>KSN</a:ExecutionTypeEnum> 
                  <a:ID>1295</a:ID> 
                  <a:Name>Get UART Baud Rate</a:Name> 
                  <a:Value>NOMAC 000169</a:Value> 
               </a:Command> 
               <a:Command> 
                  <a:CommandType>0</a:CommandType> 
                  <a:Description>Masking to 
1234********1234</a:Description> 
                  <a:ExecutionTypeEnum>KSN</a:ExecutionTypeEnum> 
                  <a:ID>12</a:ID> 
                  <a:Name>MASK_4*4</a:Name> 
                  <a:Value>0107303430342A4E</a:Value> 
               </a:Command> 
               <a:Command> 
                  <a:CommandType>0</a:CommandType> 
                  <a:Description>Masking to 
1234000000001234</a:Description> 
                  <a:ExecutionTypeEnum>KSN</a:ExecutionTypeEnum> 
                  <a:ID>14</a:ID> 
                  <a:Name>MASK_4ZERO</a:Name> 
                  <a:Value>010730343034304E</a:Value> 
               </a:Command> 
               <a:Command> 
                  <a:CommandType>0</a:CommandType> 
                  <a:Description>Masking to 
1234000x00001234</a:Description> 
                  <a:ExecutionTypeEnum>KSN</a:ExecutionTypeEnum> 
                  <a:ID>17</a:ID> 
                  <a:Name>MASK_4ZERO4_MOD10</a:Name> 
                  <a:Value>0107303430343059</a:Value> 
               </a:Command> 
               <a:Command> 
                  <a:CommandType>0</a:CommandType> 
                  <a:Description>Masking to 
123456******1234</a:Description> 
                  <a:ExecutionTypeEnum>KSN</a:ExecutionTypeEnum> 
                  <a:ID>13</a:ID> 
                  <a:Name>MASK_6*4</a:Name> 
                  <a:Value>0107303630342A4E</a:Value> 
               </a:Command> 
               <a:Command> 
                  <a:CommandType>0</a:CommandType> 
                  <a:Description>Masking to 
1234560000001234</a:Description> 
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                  <a:ExecutionTypeEnum>KSN</a:ExecutionTypeEnum> 
                  <a:ID>16</a:ID> 
                  <a:Name>MASK_6ZERO4</a:Name> 
                  <a:Value>010730363034304E</a:Value> 
               </a:Command> 
               <a:Command> 
                  <a:CommandType>0</a:CommandType> 
                  <a:Description>Masking to 
1234560x00001234</a:Description> 
                  <a:ExecutionTypeEnum>KSN</a:ExecutionTypeEnum> 
                  <a:ID>18</a:ID> 
                  <a:Name>MASK_6ZERO4_MOD10</a:Name> 
                  <a:Value>0107303630343059</a:Value> 
               </a:Command> 
               <a:Command> 
                  <a:CommandType>0</a:CommandType> 
                  <a:Description>Masking to 
123456789123456789</a:Description> 
                  <a:ExecutionTypeEnum>KSN</a:ExecutionTypeEnum> 
                  <a:ID>1253</a:ID> 
                  <a:Name>MASK_9*9</a:Name> 
                  <a:Value>0107303930392A4E</a:Value> 
               </a:Command> 
               <a:Command> 
                  <a:CommandType>0</a:CommandType> 
                  <a:Description>Masking AAMVA to 
1234********1234</a:Description> 
                  <a:ExecutionTypeEnum>KSN</a:ExecutionTypeEnum> 
                  <a:ID>20</a:ID> 
                  <a:Name>MASK_AMMVA_4*4</a:Name> 
                  <a:Value>0108303430342A4E</a:Value> 
               </a:Command> 
               <a:Command> 
                  <a:CommandType>0</a:CommandType> 
                  <a:Description>Masking AAMVA to 
1234000000001234</a:Description> 
                  <a:ExecutionTypeEnum>KSN</a:ExecutionTypeEnum> 
                  <a:ID>22</a:ID> 
                  <a:Name>MASK_AMMVA_4ZERO4</a:Name> 
                  <a:Value>010830343034304E</a:Value> 
               </a:Command> 
               <a:Command> 
                  <a:CommandType>0</a:CommandType> 
                  <a:Description>Masking AAMVA to 
1234000x00001234</a:Description> 
                  <a:ExecutionTypeEnum>KSN</a:ExecutionTypeEnum> 
                  <a:ID>25</a:ID> 
                  <a:Name>MASK_AMMVA_4ZERO4_MOD10</a:Name> 
                  <a:Value>0108303430343059</a:Value> 
               </a:Command> 
               <a:Command> 
                  <a:CommandType>0</a:CommandType> 
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                  <a:Description>Masking AAMVA to 
123456******1234</a:Description> 
                  <a:ExecutionTypeEnum>KSN</a:ExecutionTypeEnum> 
                  <a:ID>21</a:ID> 
                  <a:Name>MASK_AMMVA_6*4</a:Name> 
                  <a:Value>0108303630342A4E</a:Value> 
               </a:Command> 
               <a:Command> 
                  <a:CommandType>0</a:CommandType> 
                  <a:Description>Masking AAMVA to 
1234560000001234</a:Description> 
                  <a:ExecutionTypeEnum>KSN</a:ExecutionTypeEnum> 
                  <a:ID>23</a:ID> 
                  <a:Name>MASK_AMMVA_6ZERO4</a:Name> 
                  <a:Value>010830363034304E</a:Value> 
               </a:Command> 
               <a:Command> 
                  <a:CommandType>0</a:CommandType> 
                  <a:Description>Masking AAMVA to 
1234560x00001234</a:Description> 
                  <a:ExecutionTypeEnum>KSN</a:ExecutionTypeEnum> 
                  <a:ID>26</a:ID> 
                  <a:Name>MASK_AMMVA_6ZERO4_MOD10</a:Name> 
                  <a:Value>0108303630343059</a:Value> 
               </a:Command> 
               <a:Command> 
                  <a:CommandType>0</a:CommandType> 
                  <a:Description>Mask Other Cards 
False</a:Description> 
                  <a:ExecutionTypeEnum>KSN</a:ExecutionTypeEnum> 
                  <a:ID>28</a:ID> 
                  <a:Name>MASK_Other_False</a:Name> 
                  <a:Value>013100</a:Value> 
               </a:Command> 
               <a:Command> 
                  <a:CommandType>0</a:CommandType> 
                  <a:Description>Mask Other Cards True</a:Description> 
                  <a:ExecutionTypeEnum>KSN</a:ExecutionTypeEnum> 
                  <a:ID>27</a:ID> 
                  <a:Name>MASK_Other_True</a:Name> 
                  <a:Value>013101</a:Value> 
               </a:Command> 
               <a:Command> 
                  <a:CommandType>0</a:CommandType> 
                  <a:Description>Change Reader to HID 
Mode</a:Description> 
                  <a:ExecutionTypeEnum>KSN</a:ExecutionTypeEnum> 
                  <a:ID>1</a:ID> 
                  <a:Name>MODE_HID</a:Name> 
                  <a:Value>011000</a:Value> 
               </a:Command> 
               <a:Command> 
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                  <a:CommandType>0</a:CommandType> 
                  <a:Description>Change Reader to Keyboard 
Emulation</a:Description> 
                  <a:ExecutionTypeEnum>KSN</a:ExecutionTypeEnum> 
                  <a:ID>2</a:ID> 
                  <a:Name>MODE_KBE</a:Name> 
                  <a:Value>011001</a:Value> 
               </a:Command> 
               <a:Command> 
                  <a:CommandType>0</a:CommandType> 
                  <a:Description>Change Reader to UART 
Mode</a:Description> 
                  <a:ExecutionTypeEnum>KSN</a:ExecutionTypeEnum> 
                  <a:ID>1293</a:ID> 
                  <a:Name>MODE_UART</a:Name> 
                  <a:Value>011002</a:Value> 
               </a:Command> 
               <a:Command> 
                  <a:CommandType>0</a:CommandType> 
                  <a:Description>MSR Direction Both (Insert Reader 
Only)</a:Description> 
                  <a:ExecutionTypeEnum>KSN</a:ExecutionTypeEnum> 
                  <a:ID>36</a:ID> 
                  <a:Name>MSR_Direction_Both</a:Name> 
                  <a:Value>013203</a:Value> 
               </a:Command> 
               <a:Command> 
                  <a:CommandType>0</a:CommandType> 
                  <a:Description>MSR Direction Insert (Insert Reader 
Only)</a:Description> 
                  <a:ExecutionTypeEnum>KSN</a:ExecutionTypeEnum> 
                  <a:ID>33</a:ID> 
                  <a:Name>MSR_Direction_Insert</a:Name> 
                  <a:Value>013201</a:Value> 
               </a:Command> 
               <a:Command> 
                  <a:CommandType>0</a:CommandType> 
                  <a:Description>MSR Direction Withdraw (Insert Reader 
Only)</a:Description> 
                  <a:ExecutionTypeEnum>KSN</a:ExecutionTypeEnum> 
                  <a:ID>34</a:ID> 
                  <a:Name>MSR_Direction_Withdraw</a:Name> 
                  <a:Value>013202</a:Value> 
               </a:Command> 
               <a:Command> 
                  <a:CommandType>0</a:CommandType> 
                  <a:Description>Change Reader polling time to 1 
milisecond</a:Description> 
                  <a:ExecutionTypeEnum>KSN</a:ExecutionTypeEnum> 
                  <a:ID>6</a:ID> 
                  <a:Name>POLL_01MS</a:Name> 
                  <a:Value>010201</a:Value> 
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               </a:Command> 
               <a:Command> 
                  <a:CommandType>0</a:CommandType> 
                  <a:Description>Polling time to 5 
millisecond</a:Description> 
                  <a:ExecutionTypeEnum>KSN</a:ExecutionTypeEnum> 
                  <a:ID>7</a:ID> 
                  <a:Name>POLL_05MS</a:Name> 
                  <a:Value>010205</a:Value> 
               </a:Command> 
               <a:Command> 
                  <a:CommandType>0</a:CommandType> 
                  <a:Description>Polling time to 7 
millisecond</a:Description> 
                  <a:ExecutionTypeEnum>KSN</a:ExecutionTypeEnum> 
                  <a:ID>8</a:ID> 
                  <a:Name>POLL_07MS</a:Name> 
                  <a:Value>010207</a:Value> 
               </a:Command> 
               <a:Command> 
                  <a:CommandType>0</a:CommandType> 
                  <a:Description>Polling time to 10 
millisecond</a:Description> 
                  <a:ExecutionTypeEnum>KSN</a:ExecutionTypeEnum> 
                  <a:ID>10</a:ID> 
                  <a:Name>POLL_10MS</a:Name> 
                  <a:Value>01020A</a:Value> 
               </a:Command> 
               <a:Command> 
                  <a:CommandType>0</a:CommandType> 
                  <a:Description>Polling time to 15 
millisecond</a:Description> 
                  <a:ExecutionTypeEnum>KSN</a:ExecutionTypeEnum> 
                  <a:ID>11</a:ID> 
                  <a:Name>POLL_15MS</a:Name> 
                  <a:Value>01020E</a:Value> 
               </a:Command> 
               <a:Command> 
                  <a:CommandType>0</a:CommandType> 
                  <a:Description>This is a sample 
Command</a:Description> 
                  <a:ExecutionTypeEnum>KSN</a:ExecutionTypeEnum> 
                  <a:ID>240</a:ID> 
                  <a:Name>Sample Command 2</a:Name> 
                  <a:Value>Sample Command Value</a:Value> 
               </a:Command> 
               <a:Command> 
                  <a:CommandType>0</a:CommandType> 
                  <a:Description>Change Reader to Security Level 
3</a:Description> 
                  <a:ExecutionTypeEnum>KSN</a:ExecutionTypeEnum> 
                  <a:ID>3</a:ID> 
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                  <a:Name>SECLEV_3</a:Name> 
                  <a:Value>1503</a:Value> 
               </a:Command> 
               <a:Command> 
                  <a:CommandType>0</a:CommandType> 
                  <a:Description>Change Reader to Security Level 
4</a:Description> 
                  <a:ExecutionTypeEnum>KSN</a:ExecutionTypeEnum> 
                  <a:ID>5</a:ID> 
                  <a:Name>SECLEV_4</a:Name> 
                  <a:Value>1504</a:Value> 
               </a:Command> 
               <a:Command> 
                  <a:CommandType>0</a:CommandType> 
                  <a:Description>Send Clear AAMVA 
False</a:Description> 
                  <a:ExecutionTypeEnum>KSN</a:ExecutionTypeEnum> 
                  <a:ID>32</a:ID> 
                  <a:Name>Send_Clear_AAMVA_CardData_False</a:Name> 
                  <a:Value>013400</a:Value> 
               </a:Command> 
               <a:Command> 
                  <a:CommandType>0</a:CommandType> 
                  <a:Description>Send Clear AAMVA True</a:Description> 
                  <a:ExecutionTypeEnum>KSN</a:ExecutionTypeEnum> 
                  <a:ID>30</a:ID> 
                  <a:Name>Send_Clear_AAMVA_CardData_True</a:Name> 
                  <a:Value>013401</a:Value> 
               </a:Command> 
               <a:Command> 
                  <a:CommandType>0</a:CommandType> 
                  <a:Description>Set UART Baud Rate to 
115200</a:Description> 
                  <a:ExecutionTypeEnum>KSN</a:ExecutionTypeEnum> 
                  <a:ID>1294</a:ID> 
                  <a:Name>Set UART Baud Rate to 115200</a:Name> 
                  <a:Value>01690401</a:Value> 
               </a:Command> 
               <a:Command> 
                  <a:CommandType>0</a:CommandType> 
                  <a:Description>Set UART Baud Rate to 
19200</a:Description> 
                  <a:ExecutionTypeEnum>KSN</a:ExecutionTypeEnum> 
                  <a:ID>1297</a:ID> 
                  <a:Name>Set UART Baud Rate to 19200</a:Name> 
                  <a:Value>01690101</a:Value> 
               </a:Command> 
               <a:Command> 
                  <a:CommandType>0</a:CommandType> 
                  <a:Description>Set UART Baud Rate to 
38400</a:Description> 
                  <a:ExecutionTypeEnum>KSN</a:ExecutionTypeEnum> 
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                  <a:ID>1298</a:ID> 
                  <a:Name>Set UART Baud Rate to 38400</a:Name> 
                  <a:Value>01690201</a:Value> 
               </a:Command> 
               <a:Command> 
                  <a:CommandType>0</a:CommandType> 
                  <a:Description>Set UART Baud Rate to 
57600</a:Description> 
                  <a:ExecutionTypeEnum>KSN</a:ExecutionTypeEnum> 
                  <a:ID>1299</a:ID> 
                  <a:Name>Set UART Baud Rate to 57600</a:Name> 
                  <a:Value>01690301</a:Value> 
               </a:Command> 
               <a:Command> 
                  <a:CommandType>0</a:CommandType> 
                  <a:Description>Set UART Baud Rate to 
9600</a:Description> 
                  <a:ExecutionTypeEnum>KSN</a:ExecutionTypeEnum> 
                  <a:ID>1296</a:ID> 
                  <a:Name>Set UART Baud Rate to 9600</a:Name> 
                  <a:Value>01690001</a:Value> 
               </a:Command> 
               <a:Command> 
                  <a:CommandType>0</a:CommandType> 
                  <a:Description>Stay Powered after Good Swipe 
False(Battery Operated devices Only)</a:Description> 
                  <a:ExecutionTypeEnum>KSN</a:ExecutionTypeEnum> 
                  <a:ID>40</a:ID> 
                  <a:Name>StayPoweredAfterSwipe_False</a:Name> 
                  <a:Value>010E00</a:Value> 
               </a:Command> 
               <a:Command> 
                  <a:CommandType>0</a:CommandType> 
                  <a:Description>Stay Powered after Good Swipe 
True(Battery Operated devices Only)</a:Description> 
                  <a:ExecutionTypeEnum>KSN</a:ExecutionTypeEnum> 
                  <a:ID>39</a:ID> 
                  <a:Name>StayPoweredAfterSwipe_True</a:Name> 
                  <a:Value>010E01</a:Value> 
               </a:Command> 
               <a:Command> 
                  <a:CommandType>0</a:CommandType> 
                  <a:Description>Tracks 1 and 3 are not 
swapped</a:Description> 
                  <a:ExecutionTypeEnum>KSN</a:ExecutionTypeEnum> 
                  <a:ID>1260</a:ID> 
                  <a:Name>SWAP_TRACKS_1and3_False</a:Name> 
                  <a:Value>016C00</a:Value> 
               </a:Command> 
            </a:Commands> 
         </GetCommandListResult> 
      </GetCommandListResponse> 
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   </s:Body> 
</s:Envelope> 

 

2.4 GetCommandByMUT 
A command used to calculate the command to change a configuration option by requesting a MagTek 
Update Token from the SCRA Reader (Command 19) securely.  

2.4.1 INPUT PROPERTIES 
Property(*) Value Value Description 

CustomerCode * <string> Customer code 

Username * <string> The User Identification credential created and assigned by 
MagTek. 

Password * <string> The password for the credential. 

BillingLabel <string> Billing Label 

CustomerTransactionID <string> Customer transaction ID 

CommandID * int The Command ID obtained from the GetCommandList response. 

KSN * <string> Key Serial number obtained by sending a command 09 to the 
reader. For this operation, the KSN should be obtained from the 
reader before obtaining the update token. 

UpdateToken * <string> Update token obtained from the reader using command 19. 
 
Note: * = Required 

2.4.2 OUTPUT PROPERTIES 
Property Value Value Description 

CustomerTransactionId <string> Customer transaction ID 

MagTranId <string> Magensa assigned unique transaction ID in GUID form 

CommandType int CommandType value 

Description <string> Description of the command response. 

ExecutionTypeEnum <string> The Execution Type can be one of the following values: 
ALL,KSN,MUT 

ID int The ID echoed back from CommandID in the request. 

Name <string> Name of the command. 

Value <string> Value to be sent to the SCRA device. 
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GetCommandByMUT Request: 
<soapenv:Envelope 
xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:v2="http://www.magensa.net/RemoteServices/v2/" 
xmlns:rem="http://schemas.datacontract.org/2004/07/RemoteServicesv2.Co
re"> 
   <soapenv:Header/> 
   <soapenv:Body> 
      <v2:GetCommandByMUT> 
         <!--Optional:--> 
         <v2:request> 
            <rem:Authentication> 
       <rem:CustomerCode>customercode</rem:CustomerCode> 
 <rem:Password>password</rem:Password> 
 <rem:Username>username</rem:Username> 
            </rem:Authentication> 
            <!--Optional:--> 
            <rem:BillingLabel></rem:BillingLabel> 
            <!--Optional:--> 
            <rem:CustomerTransactionID></rem:CustomerTransactionID> 
            <rem:CommandID>34</rem:CommandID> 
            <rem:KSN>9011400B487DBC0000E8</rem:KSN> 
            
<rem:UpdateToken>423438374442433032323131394141004D53434B5052443030312
A1C911F8E301F4F953C</rem:UpdateToken> 
         </v2:request> 
      </v2:GetCommandByMUT> 
   </soapenv:Body> 
</soapenv:Envelope> 

 
GetCommandByMUT Response: 
<s:Envelope xmlns:s="http://schemas.xmlsoap.org/soap/envelope/"> 
   <s:Body> 
      <GetCommandByMUTResponse 
xmlns="http://www.magensa.net/RemoteServices/v2/"> 
         <GetCommandByMUTResult 
xmlns:a="http://schemas.datacontract.org/2004/07/RemoteServicesv2.Core
" xmlns:i="http://www.w3.org/2001/XMLSchema-instance"> 
            <a:CustomerTransactionId/> 
            <a:MagTranId>04faaf5d-e138-4da5-8875-
a654a47c3b2a</a:MagTranId> 
            <a:Command> 
               <a:CommandType>0</a:CommandType> 
               <a:Description>Encrypt using Data 
Variant</a:Description> 
               <a:ExecutionTypeEnum>MUT</a:ExecutionTypeEnum> 
               <a:ID>34</a:ID> 
               <a:Name>ENC_VARIANT_DATA</a:Name> 
               <a:Value>0106540107978E40</a:Value> 
            </a:Command> 
         </GetCommandByMUTResult> 
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      </GetCommandByMUTResponse> 
   </s:Body> 
</s:Envelope> 

 

2.5 GetCommandByKSN 
A command used to calculate the command to change a configuration option by requesting the current 
key serial number KSN from the SCRA Reader (Command 09) securely. 

2.5.1 INPUT PROPERTIES 
Property(*) Value Value Description 

CustomerCode * <string> Customer code 

Username * <string> The User Identification credential created and assigned by 
MagTek. 

Password * <string> The password for the credential. 

BillingLabel <string> Billing Label 

CustomerTransactionID <string> Customer transaction ID 

CommandID * int The Command ID obtained from the GetCommandList response. 

KSN * <string> Key Serial number obtained by sending a command 09 to the 
reader. For this operation, KSN should be obtained from the reader 
before obtaining the update token. 

KeyID * int The ID of the Key to use for the calculation. This is obtained from 
the GetKeyList Response. 

 
Note: * = Required 

2.5.2 OUTPUT PROPERTIES 
Property Value Value Description 

CustomerTransactionId <string> Customer transaction ID 

MagTranId <string> Magensa assigned unique transaction ID in GUID form 

CommandType int  

Description <string> Description of the command response. 

ExecutionTypeEnum <string> The Execution Type can be one of the following values: 
ALL,KSN,MUT 

ID int The ID echoed back from CommandID in the request. 

Name <string> Name of the command. 

Value <string> Value to be sent to the SCRA device. 
 
  



2 - SCRAv2 Operations 

Magensa Web Services| Remote Services For SCRAs | RemoteServicesv2 SCRAv2 Operations Manual 
 

Page 27 of 41 (D998200043-20) 

GetCommandByKSN Request: 
<soapenv:Envelope 
xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:v2="http://www.magensa.net/RemoteServices/v2/" 
xmlns:rem="http://schemas.datacontract.org/2004/07/RemoteServicesv2.Co
re"> 
 <soapenv:Header/> 
 <soapenv:Body> 
 <v2:GetCommandByKSN> 
 <v2:request> 
 <rem:Authentication> 
<rem:CustomerCode>customercode</rem:CustomerCode> 
 <rem:Password>password</rem:Password> 
 <rem:Username>username</rem:Username> 
 </rem:Authentication> 
 <rem:BillingLabel></rem:BillingLabel> 
 <rem:CustomerTransactionID></rem:CustomerTransactionID> 
 <rem:CommandID>1</rem:CommandID> 
 <rem:KSN>9011400B487DBC0000E0</rem:KSN> 
 <rem:KeyID>8</rem:KeyID> 
 </v2:request> 
 </v2:GetCommandByKSN> 
 </soapenv:Body> 
</soapenv:Envelope> 
 

 
GetCommandByKSN Response: 
<s:Envelope xmlns:s="http://schemas.xmlsoap.org/soap/envelope/"> 
   <s:Body> 
      <GetCommandByKSNResponse 
xmlns="http://www.magensa.net/RemoteServices/v2/"> 
         <GetCommandByKSNResult 
xmlns:a="http://schemas.datacontract.org/2004/07/RemoteServicesv2.Core
" xmlns:i="http://www.w3.org/2001/XMLSchema-instance"> 
            <a:CustomerTransactionId i:nil="true"/> 
            <a:MagTranId>ca7ecd71-f470-4edd-8e99-
f2882d23d3a4</a:MagTranId> 
            <a:Command> 
               <a:CommandType>0</a:CommandType> 
               <a:Description>Change Reader to HID 
Mode</a:Description> 
               <a:ExecutionTypeEnum>KSN</a:ExecutionTypeEnum> 
               <a:ID>1</a:ID> 
               <a:Name>MODE_HID</a:Name> 
               <a:Value>010610006B289C6A</a:Value> 
            </a:Command> 
         </GetCommandByKSNResult> 
      </GetCommandByKSNResponse> 
   </s:Body> 
</s:Envelope> 
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2.6 GetFirmwareList 

2.6.1 INPUT PROPERTIES 
Property(*) Value Value Description 

CustomerCode * <string> Customer code 

Username * <string> The User Identification credential created and assigned by 
MagTek. 

Password * <string> The password for the credential. 

BillingLabel <string> Billing Label 

CustomerTransactionID <string> Customer transaction ID 

FirmwareType <string> Type of Firmware 
 
Note: * = Required 

2.6.2 OUTPUT PROPERTIES 
Property Value Value Description 

CustomerTransactionId <string> Customer transaction ID 

MagTranId <string> Magensa assigned unique transaction ID in GUID form 

Description <string> Description of the command response. 

ID int The ID echoed back from CommandID in the request. 

DateCreated <string> Created Date 

DateModified <string> Modified Date 

Name <string> Name of Firmware 

PartNumber int PartNumber value 

File <string> This field is always null for this operation 

PreloadCommands <string> This field is always null for this operation 

PostloadCommands <string> This field is always null for this operation 

TargetID byte  

Type <string> Firmware Type 

Version <string> Version of firmware 
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GetFirmwareList Request: 
<soapenv:Envelope 
xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/" 
xmlns:v2="http://www.magensa.net/RemoteServices/v2/" 
xmlns:rem="http://schemas.datacontract.org/2004/07/RemoteServicesv2.Co
re"> 
   <soapenv:Header/> 
   <soapenv:Body> 
      <v2:GetFirmwareList> 
         <!--Optional:--> 
         <v2:request> 
            <rem:Authentication> 
               <rem:CustomerCode>customercode</rem:CustomerCode> 
 <rem:Password>password</rem:Password> 
 <rem:Username>username</rem:Username> 
            </rem:Authentication> 
            <!--Optional:--> 
<rem:BillingLabel>?</rem:BillingLabel> 
            <!--Optional:--> 
            <rem:CustomerTransactionID>?</rem:CustomerTransactionID> 
            <!--Optional:--> 
            <rem:FirmwareType></rem:FirmwareType> 
         </v2:request> 
      </v2:GetFirmwareList> 
   </soapenv:Body> 
</soapenv:Envelope> 

 
GetFirmwareList Response: 
<s:Envelope xmlns:s="http://schemas.xmlsoap.org/soap/envelope/"> 
   <s:Body> 
      <GetFirmwareListResponse 
xmlns="http://www.magensa.net/RemoteServices/v2/"> 
         <GetFirmwareListResult 
xmlns:a="http://schemas.datacontract.org/2004/07/RemoteServicesv2.Core
" xmlns:i="http://www.w3.org/2001/XMLSchema-instance"> 
            <a:CustomerTransactionId>?</a:CustomerTransactionId> 
            <a:MagTranId>5aa604e0-69bd-48b1-95d0-
92da6b92bcb3</a:MagTranId> 
            <a:Firmwares> 
               <a:Firmware> 
                  <a:DateCreated>2016-08-
29T17:12:26.753</a:DateCreated> 
                  <a:DateModified>2016-08-
29T17:12:26.753</a:DateModified> 
                  <a:Description>BLE 1000002650 version C04 
firmware</a:Description> 
                  <a:File/> 
                  <a:ID>1</a:ID> 
                  <a:Name>BLE_1000002650</a:Name> 
                  <a:PartNumber>1000002650</a:PartNumber> 
                  <a:PostloadCommands i:nil="true"/> 
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                  <a:PreloadCommands i:nil="true"/> 
                  <a:TargetID>2</a:TargetID> 
                  <a:Type>Test</a:Type> 
                  <a:Version>C04</a:Version> 
               </a:Firmware> 
               <a:Firmware> 
                  <a:DateCreated>2018-06-
11T23:06:13.180</a:DateCreated> 
                  <a:DateModified>2018-06-
11T23:06:13.180</a:DateModified> 
                  <a:Description i:nil="true"/> 
                  <a:File/> 
                  <a:ID>20</a:ID> 
                  <a:Name>eDynamo Firmware-1000003354-G0-VG02</a:Name> 
                  <a:PartNumber>100003354</a:PartNumber> 
                  <a:PostloadCommands i:nil="true"/> 
                  <a:PreloadCommands i:nil="true"/> 
                  <a:TargetID>1</a:TargetID> 
                  <a:Type>Production</a:Type> 
                  <a:Version>G0</a:Version> 
               </a:Firmware> 
               <a:Firmware> 
                  <a:DateCreated>2017-06-
21T16:02:04.507</a:DateCreated> 
                  <a:DateModified>2017-06-
21T16:02:04.507</a:DateModified> 
                  <a:Description>Main_1000003354 version E00 
firmware</a:Description> 
                  <a:File/> 
                  <a:ID>13</a:ID> 
                  <a:Name>Main_1000003354</a:Name> 
                  <a:PartNumber>1000003354</a:PartNumber> 
                  <a:PostloadCommands i:nil="true"/> 
                  <a:PreloadCommands i:nil="true"/> 
                  <a:TargetID>1</a:TargetID> 
                  <a:Type>Production</a:Type> 
                  <a:Version>E00</a:Version> 
               </a:Firmware> 
               <a:Firmware> 
                  <a:DateCreated>2017-09-
08T15:02:24.070</a:DateCreated> 
                  <a:DateModified>2017-09-
08T15:02:24.070</a:DateModified> 
                  <a:Description>Main_1000003358 version F0 
firmware</a:Description> 
                  <a:File/> 
                  <a:ID>15</a:ID> 
                  <a:Name>Main_1000003358</a:Name> 
                  <a:PartNumber>1000003358</a:PartNumber> 
                  <a:PostloadCommands i:nil="true"/> 
                  <a:PreloadCommands i:nil="true"/> 
                  <a:TargetID>1</a:TargetID> 
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                  <a:Type>Production</a:Type> 
                  <a:Version>F01</a:Version> 
               </a:Firmware> 
               <a:Firmware> 
                  <a:DateCreated>2017-07-
24T17:59:09.863</a:DateCreated> 
                  <a:DateModified>2017-07-
24T17:59:09.863</a:DateModified> 
                  <a:Description>MAIN_21030088 production version C01 
firmware</a:Description> 
                  <a:File/> 
                  <a:ID>14</a:ID> 
                  <a:Name>MAIN_21030088</a:Name> 
                  <a:PartNumber>21030088</a:PartNumber> 
                  <a:PostloadCommands i:nil="true"/> 
                  <a:PreloadCommands i:nil="true"/> 
                  <a:TargetID>1</a:TargetID> 
                  <a:Type>Production</a:Type> 
                  <a:Version>C01</a:Version> 
               </a:Firmware> 
               <a:Firmware> 
                  <a:DateCreated>2017-06-
01T22:17:22.560</a:DateCreated> 
                  <a:DateModified>2017-06-
01T22:17:22.560</a:DateModified> 
                  <a:Description>MAIN 21042840 production version J01 
firmware</a:Description> 
                  <a:File/> 
                  <a:ID>11</a:ID> 
                  <a:Name>MAIN_21042840</a:Name> 
                  <a:PartNumber>21042840</a:PartNumber> 
                  <a:PostloadCommands i:nil="true"/> 
                  <a:PreloadCommands i:nil="true"/> 
                  <a:TargetID>1</a:TargetID> 
                  <a:Type>Production</a:Type> 
                  <a:Version>J01</a:Version> 
               </a:Firmware> 
               <a:Firmware> 
                  <a:DateCreated>2017-11-
28T19:05:15.033</a:DateCreated> 
                  <a:DateModified>2017-11-
28T19:05:15.033</a:DateModified> 
                  <a:Description>MAIN_21042876 production version E00 
firmware</a:Description> 
                  <a:File/> 
                  <a:ID>16</a:ID> 
                  <a:Name>MAIN_21042876</a:Name> 
                  <a:PartNumber>21042876</a:PartNumber> 
                  <a:PostloadCommands i:nil="true"/> 
                  <a:PreloadCommands i:nil="true"/> 
                  <a:TargetID>1</a:TargetID> 
                  <a:Type>Production</a:Type> 
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                  <a:Version>E00</a:Version> 
               </a:Firmware> 
               <a:Firmware> 
                  <a:DateCreated>2018-03-
16T15:04:40.567</a:DateCreated> 
                  <a:DateModified>2018-03-
16T15:04:40.567</a:DateModified> 
                  <a:Description>MAIN 21165822 version E01 
(Production) firmware</a:Description> 
                  <a:File/> 
                  <a:ID>17</a:ID> 
                  <a:Name>MAIN_21165822</a:Name> 
                  <a:PartNumber>21165822</a:PartNumber> 
                  <a:PostloadCommands i:nil="true"/> 
                  <a:PreloadCommands i:nil="true"/> 
                  <a:TargetID>1</a:TargetID> 
                  <a:Type>Production</a:Type> 
                  <a:Version>E01</a:Version> 
               </a:Firmware> 
            </a:Firmwares> 
         </GetFirmwareListResult> 
      </GetFirmwareListResponse> 
   </s:Body> 
</s:Envelope> 
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2.7 GetFirmwareCommands 
A command used to get the command which is to be sent to the device for device authentication. 

2.7.1 INPUT PROPERTIES 
Property(*) Value Value Description 

CustomerCode * <string> Customer code 

Username * <string> The User Identification credential created and assigned by 
MagTek. 

Password * <string> The password for the credential. 

BillingLabel <string> Billing Label 

CustomerTransactionID <string> Customer transaction ID 

DeviceType <string> Type of Device 

Firmware * <string> Firmware 

KSN * <string> Key Serial number obtained by sending a command 09 to the 
reader. For this operation the KSN should be obtained from the 
reader before obtaining the update token 

KeyID * int Key Id value 

SerialNumber * int  

AdditionalRequestData Key/Value 
pair 

 

 
Note: * = Required 

2.7.2 OUTPUT PROPERTIES 
Property Value Value Description 

CustomerTransactionID <string> Customer transaction ID 

MagTranId <string> Magensa assigned unique transaction ID in GUID form. 

Commands <string> Commands 

PostloadCommands <string> list of Firmware commands 

PreloadCommands <string> list of Firmware commands 
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GetFirmwareCommands Request: 
<s:Envelope xmlns:s="http://schemas.xmlsoap.org/soap/envelope/"> 
   <s:Body> 
      <GetFirmwareCommands 
xmlns="http://www.magensa.net/RemoteServices/v2/"> 
         <request 
xmlns:a="http://schemas.datacontract.org/2004/07/RemoteServicesv2.Core
" xmlns:i="http://www.w3.org/2001/XMLSchema-instance"> 
            <a:Authentication> 
               <a:CustomerCode>customercode</a:CustomerCode> 
               <a:Password>password</a:Password> 
               <a:Username>username</a:Username> 
            </a:Authentication> 
            <a:BillingLabel i:nil="true"/> 
            <a:CustomerTransactionID i:nil="true"/> 
            <a:AdditionalRequestData i:nil="true" 
xmlns:b="http://schemas.datacontract.org/2004/07/System.Collections.Ge
neric"/> 
            <a:DeviceType>tDynamo</a:DeviceType> 
            <a:Firmware>MTAwMDAwMzM1OA==</a:Firmware> 
            <a:KSN>9010010B50860200000A</a:KSN> 
            <a:KeyID>119</a:KeyID> 
            <a:SerialNumber/> 
         </request> 
      </GetFirmwareCommands> 
   </s:Body> 
</s:Envelope> 
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GetFirmwareCommands Response: 
<s:Envelope xmlns:s="http://schemas.xmlsoap.org/soap/envelope/"> 
   <s:Body> 
      <GetFirmwareCommandsResponse 
xmlns="http://www.magensa.net/RemoteServices/v2/"> 
         <GetFirmwareCommandsResult 
xmlns:a="http://schemas.datacontract.org/2004/07/RemoteServicesv2.Core
" xmlns:i="http://www.w3.org/2001/XMLSchema-instance"> 
            <a:CustomerTransactionId i:nil="true"/> 
            <a:MagTranId>9846cb59-3f92-4063-9d8c-
092eec4e8579</a:MagTranId> 
            <a:Commands 
xmlns:b="http://schemas.microsoft.com/2003/10/Serialization/Arrays"> 
               <b:string>610E313030303030333335380674CAE4</b:string> 
            </a:Commands> 
            <a:PostloadCommands> 
               <a:FirmwareCommand> 
                  <a:Operation>NOMAC</a:Operation> 
                  <a:Value>6200</a:Value> 
               </a:FirmwareCommand> 
               <a:FirmwareCommand> 
                  <a:Operation>NOMAC</a:Operation> 
                  <a:Value>6600</a:Value> 
               </a:FirmwareCommand> 
               <a:FirmwareCommand> 
                  <a:Operation>NOMAC</a:Operation> 
                  <a:Value>6700</a:Value> 
               </a:FirmwareCommand> 
               <a:FirmwareCommand> 
                  <a:Operation>WAIT</a:Operation> 
                  <a:Value>10000</a:Value> 
               </a:FirmwareCommand> 
            </a:PostloadCommands> 
            <a:PreloadCommands> 
               <a:FirmwareCommand> 
                  <a:Operation>NOMAC</a:Operation> 
                  <a:Value>6800</a:Value> 
               </a:FirmwareCommand> 
               <a:FirmwareCommand> 
                  <a:Operation>WAIT</a:Operation> 
                  <a:Value>10000</a:Value> 
               </a:FirmwareCommand> 
               <a:FirmwareCommand> 
                  <a:Operation>DETECTDEVICE</a:Operation> 
                  <a:Value/> 
               </a:FirmwareCommand> 
               <a:FirmwareCommand> 
                  <a:Operation>NOMAC</a:Operation> 
                  <a:Value>6000</a:Value> 
               </a:FirmwareCommand> 
            </a:PreloadCommands> 
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         </GetFirmwareCommandsResult> 
      </GetFirmwareCommandsResponse> 
   </s:Body> 
</s:Envelope> 

2.8 GetFirmwareByMUT 

2.8.1 INPUT PROPERTIES  
Property(*) Value Value Description 

CustomerCode * <string> Customer code 

Username * <string> The User Identification credential created and assigned by 
MagTek. 

Password * <string> The password for the credential. 

BillingLabel <string> Billing Label 

CustomerTransactionID <string> Customer transaction ID 

FirmwareID * int The Firmware ID obtained from the GetFirmwareList response. 

KSN * <string> Key Serial number obtained by sending a command 09 to the 
reader. For this operation, the KSN should be obtained from the 
reader before obtaining the update token. 

UpdateToken* <string> Update token obtained from the reader using command 19. 
 
Note: * = Required 

2.8.2 OUTPUT PROPERTIES 
Property Value Value Description 

CustomerTransactionId <string> Customer transaction ID 

DateCreated <string> Created Date 

DateModified <string> Modified Date 

ID int ID of firmware 

Description <string> Description 

File <string> Hex 

Name <string> Name of the firmware 

PartNumber <string> PartNumber value 

PostloadCommands <string> List of Firmware commands 

PreloadCommands <string> List of Firmware commands 

TargetID byte TargetID of firmware 

Type <string> Type of firmware 

Version <string> Version of firmware 
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GetFirmwareByMUT Request: 
<s:Envelope xmlns:s="http://schemas.xmlsoap.org/soap/envelope/"> 
   <s:Body> 
      <GetFirmwareByMUT 
xmlns="http://www.magensa.net/RemoteServices/v2/"> 
         <request 
xmlns:a="http://schemas.datacontract.org/2004/07/RemoteServicesv2.Core
" xmlns:i="http://www.w3.org/2001/XMLSchema-instance"> 
            <a:Authentication> 
               <a:CustomerCode>customercode</a:CustomerCode> 
               <a:Password>password</a:Password> 
               <a:Username>username</a:Username> 
            </a:Authentication> 
            <a:BillingLabel/> 
            <a:CustomerTransactionID/> 
            <a:FirmwareID>1</a:FirmwareID> 
            <a:KSN>9010010B50860200000A</a:KSN> 
            
<a:UpdateToken>423530383630323037313631394141004D53434B545354303031F59
7EDF043A30956DF93</a:UpdateToken> 
         </request> 
      </GetFirmwareByMUT> 
   </s:Body> 
</s:Envelope> 
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GetFirmwareByMUT Response: 
<s:Envelope xmlns:s="http://schemas.xmlsoap.org/soap/envelope/"> 
   <s:Body> 
      <GetFirmwareByMUTResponse 
xmlns="http://www.magensa.net/RemoteServices/v2/"> 
         <GetFirmwareByMUTResult 
xmlns:a="http://schemas.datacontract.org/2004/07/RemoteServicesv2.Core
" xmlns:i="http://www.w3.org/2001/XMLSchema-instance"> 
            <a:CustomerTransactionId/> 
            <a:MagTranId>e4aaf294-47e1-48b7-a5eb-
7290cbe2cf94</a:MagTranId> 
            <a:Firmware> 
               <a:DateCreated>2016-08-29T17:12:26.753</a:DateCreated> 
               <a:DateModified>2016-08-
29T17:12:26.753</a:DateModified> 
               <a:Description>BLE 1000002650 version C04 
firmware</a:Description> 
               <a:File>File Response value</a:File> 
               <a:ID>1</a:ID> 
               <a:Name>BLE_1000002650</a:Name> 
               <a:PartNumber>1000002650</a:PartNumber> 
               <a:PostloadCommands> 
                  <a:FirmwareCommand> 
                     <a:Operation>NOMAC</a:Operation> 
                     <a:Value>0200</a:Value> 
                  </a:FirmwareCommand> 
                  <a:FirmwareCommand> 
                     <a:Operation>WAIT</a:Operation> 
                     <a:Value>5000</a:Value> 
                  </a:FirmwareCommand> 
                  <a:FirmwareCommand> 
                     <a:Operation>DETECTDEVICE</a:Operation> 
                     <a:Value/> 
                  </a:FirmwareCommand> 
                  <a:FirmwareCommand> 
                     <a:Operation>NOMAC</a:Operation> 
                     <a:Value>970101</a:Value> 
                  </a:FirmwareCommand> 
                  <a:FirmwareCommand> 
                     <a:Operation>DETECTDEVICE</a:Operation> 
                     <a:Value/> 
                  </a:FirmwareCommand> 
               </a:PostloadCommands> 
               <a:PreloadCommands> 
                  <a:FirmwareCommand> 
                     <a:Operation>NOMAC</a:Operation> 
                     <a:Value>970101</a:Value> 
                  </a:FirmwareCommand> 
                  <a:FirmwareCommand> 
                     <a:Operation>MAC</a:Operation> 
                     <a:Value>91040A3F1434</a:Value> 



2 - SCRAv2 Operations 

Magensa Web Services| Remote Services For SCRAs | RemoteServicesv2 SCRAv2 Operations Manual 
 

Page 39 of 41 (D998200043-20) 

                  </a:FirmwareCommand> 
                  <a:FirmwareCommand> 
                     <a:Operation>DETECTDEVICE</a:Operation> 
                     <a:Value/> 
                  </a:FirmwareCommand> 
                  <a:FirmwareCommand> 
                     <a:Operation>WAIT</a:Operation> 
                     <a:Value>5000</a:Value> 
                  </a:FirmwareCommand> 
               </a:PreloadCommands> 
               <a:TargetID>2</a:TargetID> 
               <a:Type>Test</a:Type> 
               <a:Version>C04</a:Version> 
            </a:Firmware> 
         </GetFirmwareByMUTResult> 
      </GetFirmwareByMUTResponse> 
   </s:Body></s:Envelope>  
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3 Status Codes and Messages 
Status Codes and Messages returned by Magensa for PPSCRAv2 Operations. 
 
Internal errors 
Property StatusMsg Notes 

5000 Unknown Error  
 
Input Validation Errors 
Property StatusMsg Notes 

602 KSN is required  

603 CustomerCode is required  

604 Username is required  

605 Password is required  

607 KSN is not valid Either the value was not HEX, or the value was too 
long. 

615 CustomerTransactionID is not valid Occurs if the length is more than 256 characters. 

616 BillingLabel is not valid Occurs if the length is more than 64 characters. 

617 KeyID is not valid Value was 0 

618 UpdateToken is not valid Value was not HEX or too long. 

619 UpdateToken is required  

620 CommandID is not valid Value was 0. 
 
Other Errors 
Property StatusMsg Notes 

701 Access Denied Returned, when user cannot be authenticated or 
authorized for any reason such as invalid username, 
invalid password or account locked. 

702 Device Not Allowed The device is not active in the database. 

704 Invalid command type for this  
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